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1. Installation 
ADP Software is compressed and requires installation before using it. 

Users may install the software from the CD or floppy disk.  

The software is available from http://www.hitech-america.com, or your 

local dealer.  

1.1.  Installation Procedures 

1.   Boot up your computer in  Win95/98/Me/2000/XP environment. 

2.   If CD is used for ADP installation, select the “Run” option in the 

windows Start Menu. Click “Browse” and locate “ADP 

\disk1\Setup.exe” in the CD-Rom drive. Run the installation program 

(Setup.exe) See Fig 1-1. 

 

Fig 1-1 Run the installation program (Setup.exe) in Windows 

3.   Click “OK” button. System will prepare for installation. See Fig 1-2.  
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Fig 1-2 Installation process is started 

4.   First, a message is displayed in the center of the screen, asking user 

to confirm the destination hard drive and directory for ADP 

installation (See Fig 1-3). The default directory is C:\HITECH ADP. 

You may change hard drive and directory at this point  by clicking on 

“Browse…” button. 

 

Fig 1-3 Destination hard drive and directory for ADP insta llation 
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5.   After clicking “Next”, the system starts the installation automatically. 

(See Fig 1-4) 

 

Fig 1-4 ADP software installs automatically  

6.   After installation is complete, the system creates an ADP icon 

automatically. (Fig. 1-5) 

 

Fig. 1-5 The ADP icon 

7.   After installation is complete, the ADP software is located in the 

specified directory. To launch the ADP program, simply click on the 

ADP icon using the mouse. 
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2.  ADP Program Environment and 

Objects Overview 

2.1.  ADP Program Environment 

 

Fig. 2-1 ADP Program Environment overview 

1.  When entering the ADP program for the first time, and no new 

application file is open, only the “File” and “Help” menu items will 

be displayed in the ADP Program Window.  

2.   When starting ADP thereafter, the last saved application is opened 

and displayed automatically.  

Window Title 

(Chinese 

acceptable ) 

Draw 
Toolbox 

Basic Objects 
Toolbox 

Edit  Toolbox 

Monitor  Toolbox 

Ladder Toolbox 

Menu Bar 

Title Bar 

Status Bar 

Text 
Toolbox 

Bitmap 
Toolbox 

Window 
Workspace  
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 Title Bar 

Window name and directory path of current working application. (If 

application file is not saved yet, the name of “untitled”  will be 

displayed.) 

 Menu Bar 

There are 13 menus with pull-down lists: “File”, “Edit”, “View”, 

“Screen”, “Draw”, “Object”, “Library”, “Application”, “Tool”, 

“Options”, “LadderPlus”, “Window”, and “Help”. 

 Window Workspace 

Area to design and build Screens, i.e., design area for the actual screens 

shown on HMI. 

2.2.  ADP Menu Bar 

There are 13 menus with pull-down lists in ADP software’s menu bar. 

This provides what designers need to design and edit  HMI 

applications—designing objects, buttons, text display, graphics, and 

screen layout. The following sections individually introduce each menu 

and the functions of each menu provided in its pull-down list for ADP 

software operations. Refer to the ADP Software  U s e r’s  Manual  for 

detailed information.  

2.3.  File 

File Menu provides the File Management System for the ADP 

applications.  

2.3.1  New  

Create a new application file. 
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2.3.2  Open  

Open a previously designed application file. File types which could be 

opened include *.P3F and *.V3F.  

2.3.3  Close 

Close the 

operation of 

current 

application file. 

2.3.4  Save  

Save the current application file directly using its original directory path 

and file name.  

2.3.5  Save As 

Save the application using a different file name. File type is set as 

“*.V3F”. 

2.3.6  Print 

There are 7 printing options available: Workstation Setup, Screen 

Overview, Screen Image, Tags, Ladder, Status Chart, and Initial Values. 

 

NOTE: The “Ladder”, “Status Chart”, and “Initial 
Values” options are only available for selecting 
PWS models with Ladder.  

2.3.7  Upload Application 

ADP will upload the application from HMI to PC and save it as a 

“*.AP1” or “*.AP2” file. ADP cannot open or edit files of these types. 

2.3.8  Download Application From 

ADP downloads a “*.AP1” or “*.AP2” file from PC to HMI. 

2.3.9  Upload Recipes 

ADP uploads the recipes from HMI to PC and saves it as an *.RCP file. 

 

Note: “*.P3F” application files are 
created by versions prior to ADP 3.0. 
“*.V3F” application files are created 
by ADP version 3 .0 and after.  
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2.3.10  Download Recipes 

ADP selects a recipe file with file extension *.RCP and downloads it to 

HMI. 

 

 

2.3.11  Download Source 

ADP downloads the source code of a HMI application to HMI and save it 

in the flash memory as a backup file. 

2.3.12  Upload Source 

ADP uploads and restores the source code of a stored application from 

HMI to PC and saves it as a *.V3F file. Use this command to edit or 

save your application. Make sure the “Download Source” was executed 

before using this command, i.e., HMI must have the source codes of the 

application downloaded before it could be uploaded.  

 

  

2.3.13  Files 1 ~ 4 

The last four applications are listed at the bottom of the file menu’s 

pull-down list.  

2.4.  Edit 

The Edit Menu provides the ADP a management system for objects 

with the following functions: “copy/delete”, “align/make same size”, 

“bring to next/send to previous”, and “edit”. The grayed-out items in 

the pull down menu are not available. (The icons in the description 

indicate shortcuts in the toolbar). 

 

Note:  PWS500, PWS700, and PWS1711 do not 
support the recipe function and hence both commands 
are not supported. 

 

Note:  Only PWS3760 series , PWS3260 series, 
PWS1760-xxxR support this function.  
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2.4.1  Duplicate 

Make fast multiple copies of selected objects, such as Numeric Entry 

and Button objects.  Not only the copied objects are distributed evenly, 

associated PLC data addresses are incremented accordingly, as in Fig. 

2-3. 

  Fig. 2-3 

2.4.2  Decompose Shape  

Use this function to decompose a  Shape  object.  

2.4.3  Alignment 

Align objects to the left , horizontal center , right , top , 

vertical center , or bottom . 

2.4.4  Make Same Size 

Make objects the same width as specified by Width , or same height 

as by Height , or same Height and Width as by Both .  

2.4.5  Nudge 

Designer may nudge (move) the selected object left , right , up , 

or down  and thus adjust its position in the display.  
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2.4.6  Layer 

Adjust the layer of an object from other overlay objects .  

2.4.7  Group  

Group selected objects as a set of objects making moving and copying 

easier.  

2.4.8  Ungroup  

Ungroup a group of objects back to individual objects.  
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2.5.  View 

The View Menu provides functions for Zooming, Language Selection 

1 ~ 5, Whole Screen Display or Whole Screen Display with I/O 

labels.  

2.5.1  Whole Screen and I/O Labels 

Provides a whole screen view of screen objects and associated I/O 

labels.  

2.5.2   Languages 1~5 

The Languages 1 ~ 5 options under the View Menu could switch 

screen design from one language to another language .  

2.5.3   Zoom 

Zoom in or out the current screen.  

2.5.4  Touch Grid 

Display or hide the grid on touch panel.  

 

Note: Only PWS700T supports this function. 

2.5.5  Toolbars 

Display or hide various toolbars. 

2.6.  Screen 

The Screen Menu provides functions to open a new/existing Screen, copy 

Screen, and for changing screen properties. 

2.6.1 New Screen  

Define the Screen name and number when create a new screen. For 

PWS500/700/1711 /2100/3700 the  range of screen number is 1-255. For 

PWS1760/3160/3260/3760 the range of screen number is 1-999. 
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2.6.2  Open Screen  

Open an existing screen, as in Fig. 2-6.  

 

Fig.2-6 Open Screen 

2.6.3  Close Screen 

Close the Screen being designed.  

2.6.4  Open Macro 

When HMI switches to this screen, it will run the programs defined in 

the Open Macro once.  

2.6.5  Close Macro 

When HMI closes this screen, it will run the programs defined in the 

Close Macro once.  

2.6.6  Cyclic Macro  

When HMI stays in this screen, it will run periodica lly the programs 

defined in the Cyclic Macro.  

2.6.7  Properties  

This enables a  designer to define or edit  the current screen name and 

number, whether the screen is a base screen or sub-screen, printable 

areas, screen background style , read blocks , and auxiliary keys. See 

Provides screen 
preview that  makes 
screen select ion easier  
for the designer.  
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Fig.2-7.  

  

 

 

 

 

Fig. 2-7 Screen properties 

 

Note:   Only the PWS500S/PWS700X/PWS3760 
models support auxiliary keys. 

Speci f ies the screen as a 
sub-screen,  i ts  s ize,  and 
display locat ion. Sub-screen 
is an overlay within the main 
screen. 

Set pr intable area of the 
screen. 

Speci fy the screen as a base 
screen 

Changes screen name and 
number  
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Fig.2-7 Read Blocks Settings Tab in Screen Properties dialog box 

2.7.  Draw 

The Draw Menu provide s an easy graphic drawing system, with lines, 

rectangles, circles, arcs, etc.  

 

The length of  the PLC registers is 
set  by the word.  I f  D100 has a 
length of 20, i t  covers words  in  
D130~D149. 

Data wi th in the Read Blocks could be 
accessed and displayed faster  than 
data outside the blocks. In addi t ion,  
each screen has separate read 
b locks . 

The length of  the PLC registers is 
set by the word. I f  M0 has a length 
of  1 (1 word = 16 bi ts) ,  i t  covers bi ts 
in M0~M15. 

For data outside the Read Blocks, 
specify the number to rea d per 
access . 

Drawing 
Objects  

True Type Text selects font from Windows, 
available only for SoftPanel HMI. 

Place Shape objects  in the screen . 

Drawing toolbox 

Place Bitmap image(s) in t he  screen . 



ADP Program Environment and Objects Overview 

Version 3   ADP Software Quick Manual 2 -11  

Fig.2-8 Draw menu 

2.8.  Object 

The Object Menu provides an object design 

management system, with Buttons, Numeric Entry, 

Multistate , Indicators objects, etc. 

2.8.1  Push Buttons 

Several types of push buttons  are available in the 

menu. Refer to Fig.2-10 for each menu item.  
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Push Button 
Type Icon Function 

Set Button  
Sets contact  to ON and remains ON upon releasing or 
depress ing . 

Reset  Button   
Resets contact to OFF and remains OFF upon releasing 
or  depress ing . 

Maintained 
But ton  

Sets contact  to ON and remains ON upon releasing; 
clicking once more to set contact to OFF.  

Momentary 
But ton  

Hold button to turn ON, releasing turns it OFF.  

Multistate Button   

This  but ton  has  3  s ta tes ;  push  once  to  send  S 0  s ignal to 
PLC; pushing a second t ime sends an S1 signal to PLC; 
pushing a third t ime sends an S2  signal to PLC. This 
button cycles from S 0 ? S1 ? S2 ? S0,  or in reverse from 
S0 ? S2 ? S1 ? S0 . The maximum number of states allowed 
is  256. 

Set Value Button  
Upon pressing,  HMI displays the buil t -in 10-Key keypad 
on the screen for  value input .  When “Enter” is  pressed,  
HMI sends the value  to the related registe r in the PLC. 

Set  Constant  
But ton  

Upon pressing,  HMI sends  a  speci f ied  cons tant  to  the  
related register in the PLC. 

Increment/Decrem
ent  But tons 

 

 

Upon pressing,  HMI first re ads the PLC registe r content  
and increases/decreases by the specif ied value.  The 
calculated result  is  writ t en  back to the  reg is te r in  the  
PLC. 

Goto Screen 
But ton  

Pressing once direct ly switches HMI to a specif ied 
screen . 
Some important  propert ies in the  d ia log  box: 
“Enabled by”--switch screen only when the specif ied 
PLC regis ter bit  i s  ON. 
“Acknowledge Alarm” --HMI has acknowledged the 
current message alert . 
“Notify ”? Upon switching screen,  this  t r iggers a  related 
PLC register bit . 

Previous Screen  
Pressing once,  HMI will switch back to t he  previously 
displayed screen. 

Data to Text 
Conversion 
But ton 

 

Convert data from the Logging Buffers, Recipes , Alarm 
History file, and Alarm Frequency file into a t ext file 
(*.PRN) and save it .  Data is accessible by word 
processing software such as Excel,  Word, and Notepad. 
(Supported only by SoftPanel).  

Action Button 
 17 actions could be defined from Action button.  

 Contrast Up   Press to increase  screen contras t  of  HMI.  (Not  supported 
by SoftPanel) 

 Cont ras t Down   Press  to  decrease screen contrast  of  HMI.  (Not  supported 
by SoftPanel) 

 Save  Cont ras t  Press for HMI to  save contras t  se t t ings .  (Not  supported 
by SoftPanel) 

 Password Table  Pressin g once displays  a  password table. Operation 
allowed when LEVEL= 1. 
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 Reenter 
Password  

 Pressing once displays  a  window for re -entering the 
password. 

 Set Lowest User 
Level 

 Press ing  once  se t s  the  security level to the lowest level,  
LEVEL=3. 

 
Print Screen   Pressing once prints  the specif ied Printable Area of the 

current  screen. (Hardcopy Printing). 
 Goto System 
M e n u 

 Pressing once switches back to the system’s menu 
screen. Operation allowed when LEVEL= 1. 

 Turn off  
Backlight 

 Press ing once turns  off  the backlight.  (Not  supported by 
SoftPanel)  

 
Alarm Ack  Pressing once acknowledges the alarm and puts  the 

system back in operation. 
 
Set Time & Date  Set  the  HMI system time, date and week. (Not supported 

by SoftPanel)  
 Select Languages 
1~5 

 Switch the  screen from the current language to the 
specif ied language. 

 
Select Screen  Select  a screen to switch to.  (Supported only by 

SoftPanel) 
 
Name Recipe  Name a recipe, either in English or Chinese. (Supported 

only by SoftPanel) 
 Select Recipe  Search for a recipe.  (Supported only by SoftPanel) 
 Print Report   Print data f rom the Logging Buffers,  including history, 

alarm history and recipes.  (Supported only by SoftPanel) 
 
Run Application  Run other Windows’s  executable program (*.exe). 

(Supported only by SoftPanel)  

Fig.2-10 Object -> Push Button menu 
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Fig.2-11 Button Properties dialog box and settings  

Attributes Tab  

Write  Write to related contact of PLC 

Read 

Read from the related PLC contact. If 
not specified, use the same location as 
“Write” . A different location may be 
specified also.  

Minimum Hold Time  Hold button for specified time, before 
HMI writes to the PLC. 

Operator Confirmation 
If selected, HMI  will automatically 
request “confirmation” . After “Yes”  is 
pushed, HMI sends signal to PLC. 

Use ON Macro ON Macro: run programs in ON Macro 
when the button state is ON. 

Use OFF Macro OFF Macro: run programs in OFF 
Macro when the button state is OFF  

External Key Only PWS500S700X/ 2100 support 
external keys  

Shape Tab Frame and color of the button 

State  Tab Add or delete a state of a button 
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Text Tab  Design text and font size of a button  

Graphic Tab Bitmap selection and setting of a button 

2.8.2  Numeric Entry  

By pressing this  object, the HMI will display the built-in 10-key keypad 

from which you may input value(s). The HMI writes the value to the 

PLC register  when ENTER is pressed.  

 

Fig.2-12 Numeric Entry  Properties dialog box and settings  

Before Writing 
Touch the value input button to notify contact 
that M5= on.  When a  value is entered and 
“ENTER” is pressed, notify that M5=off.  

After Writing 
When a value is entered and “ENTER” is 
pressed, notify that M5=on. Requires PLC 
program to reset. 

Scaling 

Supported only for values of binary format, 
using the formula Y=aX+b. Y = HMI displayed 
va lue, X= PLC stored value, a=Gain, b=Offset.  
If a=0.5, b=2, when HMI inputs 10 (Y=10), 
PLC writes 16 (X=16). 
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2.8.3  Character Entry  

Pressing the Character Entry object displays the system built -in ASCII 

keypad on screen with which you may enter ASCII characters. (The 

string has a maximum length of 28 characters.) When “Enter” is pressed, 

the ASCII code is sent to the register in the PLC. 

 

Note:   PWS500/PWS700/PWS2100 does not support 
this function. 

2.8.4 Indicators  

There are two types of indicators: 

1.  Multistate Indicators: HMI reads the contact status or register value 

from PLC and automatically displays corresponding designed content 

on the HMI screen. The maximum number of states is 256 (if “Value” 

selected) or 16 (if “LSB” selected) or 2 (if “Bit” selected). 

2.  Range Indicators : HMI reads register values from PLC and 

automatically calculates the difference according to the boundary 

value of the current status. Then the contents of the current status are 

displayed on the HMI screen, according to the calculated results. 

2.8.5  Numeric Display  

HMI reads the register value from the PLC and directly displays it on 

the HMI screen. (does not support input) See Fig. 2-13. 

 

Fig.2-13 Numeric Display 

2.8.6  Character Display  

HMI reads the ASCII value of the register from the PLC and converts 

the ASCII code into alphanumeric characters for display on the HMI 

screen. (does not support input.) See Fig. 2-14.  
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Fig.2-14 Character Display 

2.8.7  Message Display 

There are 5 types of Message Display. The difference between Message 

Display and Indicator is that Message Display contains only text, no 

graphic s, however Indicator could have both text and graphic s.  

Prestored Message Display  

HMI reads the contact sta te  or register value from the PLC and 

automatically displays designed content on the HMI screen according to 

the state/value . Maximum number of states is 256 (if “Value” selected) 

or 16 (if “LSB” selected) or 2 (if “Bit” selected.) 

Moving Sign  

HMI reads the contact state  or register value from the PLC and 

automatically displays designed content on the HMI screen according to 

current state/value. The effect is revolving text display, moving from 

right to the left. “Number of text to be revolved at a time” and revolving 

speed are configurable  at design time.  

Time Display  

HMI reads the time value of the internal REAL TIME CLOCK and 

displays the content directly on the HMI screen. (Not supported by 

PWS500/PWS700.) 

Date Display  

HMI reads the date value of the internal REAL TIME CLOCK and 

displays the content directly on the HMI screen. (Not supported by 

PWS500/PWS700.) 
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Day-of-Week Display 

HMI reads the week value of the internal REAL TIME CLOCK and 

displays the content directly on the HMI screen. (Not supported by 

PWS500/PWS700.) 

2.8.8  Bar Graph 

There are 2 types of Bar Graph: 

Normal Bar Graph  

HMI reads values of the PLC register and converts data into Bar Graph 

for display on the HMI screen. See Fig. 2-15.  

   

Fig.2-15 Normal Bar Graph 

 

Note: Suppose the PLC D100 is specified for access. If 
the “Limits” and “Target/Objective Value” are checked, 
D101 is the Target Value, D102 the Lower Limit and 
D103 the Upper Limit. 

Deviation Bar Graph 

HMI reads values of the PLC register and compares them with the 

normal. Then converts the difference as Bar Graph and displays on the 

HMI screen.  See Fig. 2-16 for settings. When the PLC register D100 has 

a value of 60 (D100=60), it displays the PLC Value (60) –  Normal (50) = 

10. See Fig. 2-17. When the PLC has a value of 80 (D100=80), it 

displays the PLC Value (80) –  Normal (50) = 30. Since 30 is greater than 

the Upper Limit (25), the display color is changed. See Fig. 2-18. 
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Fig. 2-16 Settings of Devia tion Bar Graph Fig.2-17 Fig.2-18 

2.8.9  Trend Graph 

HMI reads a series  of values  from the related PLC register and converts 

them into Trend Graph for display on the HMI screen. See Fig. 2-19. A 

trend graph may have a maximum number of 4 curves on it. 

 

Fig. 2-19 Trend Graph Display 

 

Note: 

1. Information about Set Flag, Clear Flag, System 
Control, please refer to ADP Software User’s  Manual. 

2. “Number of Points” indicates the maximum display 
points of the Bar Graph’s X-Axis. 

3. Sampling rule is described in the following. If the 
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access field is D100 with 2 curves, then 
D100=Sampling Number, 
D101=1s t  dot on 1s t  curve, 
D102=1s t  dot on 2n d  curve, 
D103=2n d  dot on 1s t  curve, 
D104=2n d  dot on 2n d  curve, 
: 
: 
When Flag=ON, HMI converts the data stream into 
Trend Graph for display on the HMI screen.  

2.8.10  X-Y Chart 

HMI reads a series  of values  from the related PLC register. Then 

converts them into curves and displays on the HMI screen. See Fig. 2-20. 

An X-Y Chart may have a maximum number of 4 curves on it. 

 

Fig.2-20 X-Y Chart display 

 

Note: 

1. Information about Set Flag, Clear Flag, System 
Control, please refer to ADP U s e r’s  Manual.  

2. Sampling rule is described as followings. If the access 
field is D100 with 2 curves, then 

D100=Sampling Number, 
D101=X-axis value of 1s t  point 1s t  curve  
D102=Y-axis value of 1s t  point 1s t  curve  

s t n d
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D103=X-axis value of 1s t  point 2n d  curve  
D104=Y-axis value of 1s t  point 2n d  curve  
D105=X-axis value of 2n d  point 1s t  curve  
D106=Y-axis value of 2n d  point 1s t  curve  
D107=X-axis value of 2n d  point 2n d  curve  
D108=Y-axis value of 2n d  point 2n d  curve  
: 
: 
When Flag=ON, the HMI converts the data stream into 
curves for display on the HMI screen.  

2.8.11  Panel Meter   

Functions of the Panel Meter object Supported in ADP allows designer 

to build panel meters easier and faster.  There are 2 types of Panel Meter, 

see Fig. 2-21.  

1.  Round  

2.  Rectangular .   

 

Fig. 2-21 Panel Meter object 

 

Note: Suppose D100 is specified for access. If the 
“Variable target/range  Limits” is checked, D101 is the 
Target Value, D102 is the Lower Range  and D103 Upper 
Range .  

2.8.12  Pie Graph 

HMI reads register values in the PLC. Converts values into a 360 pie 
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graph and displays on the HMI screen.  

2.8.13  Dynamic Graph 

There are four types of  Dynamic Graph: 

Animated Graphic 

PLC could control the graphic at an arbitrary position on the HMI screen. 

PLC could also control graphic movement along X-axis and Y-axis, and 

the display of different graphic s.  

Suppose D100 is specified for access. D100 controls the exchange of 

graphics; D101 controls movement along X-axis; D102 controls 

movement along Y-axis.  

State Graphic  

PLC could control the State Graphic at  a  fixed position on the HMI 

screen by changing to different graphics. (different graphic files) 

Suppose D100 is specified for access. D100 controls the exchange of 

graphics. 

Dynamic Rectangle 

PLC could control the Rectangular Graphic at an arbitrary position on 

the HMI screen. It could also control movement along X-axis and Y-axis, 

and varies its size and color.  

Suppose D100 is specified for access.  

Re-posi t ion 
Re-size  
Re-coloring 
D100=Width 
D101=Height 
D102=X 
D103=Y 
D104=Color 

Re-position  
Re-size  
Fix Color 
D100=Width 
D101=Height 
D102=X 
D103=Y 

Fix Position  
Re-size  
Re-coloring 
D100=Width  
D101=Height 
D102=Color 

Fix Position 
Re-size 
Fix Color 
D100=Width 
D101=Height  

Re-posi t ion 
Fix Size 
Re-coloring 
D100=X 
D101=Y 
D102=Color 

Re-Position  
Fix Size  
Fix Color 
D100=X 
D101=Y 

Fix Position 
Fix Size 
Re-coloring 
D100=Color 
(Color Depth, 
16 
Colors=0 -15, 
256 
Colors=0 -255) 
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Dynamic Circle 

PLC could control Dynamic  Graphic at an arbitrary position on the HMI 

screen. It could also control movement along X-axis and Y-axis, and 

varying its radius and color. 

Suppose D100 is specified for access.  

Re-Center 
Re-Radius  
Re-Coloring 
D100=Radius 
D101=X 
D102=Y 
D103=Color 

Re-Center 
Re-Radius 
Fix Color 
D100=Radius 
D101=X 
D102=Y 

Fix Center 
Re-Radius 
Re-Coloring  
D100=Radius 
D101=Color 

Fix Center 
Re-Radius 
Fix Color 
D100=Radius  

Re-Center 
Fix Radius 
Re-Coloring 
D100=X 
D101=Y 
D102=Color 

Re-Center 
Fix 
Radius 
Fix Color 
D100=X 
D101=Y 

Fix Center 
Fix Radius  
Re-Coloring 
D100=Color 
(Color Depth, 
16 
Colors=0-15, 
256 
Colors=0-255) 

 

2.8.14  Historical Display 

There are three types of Historical Display. To display correctly, the 

user must first set the fields in Application Menu à Workstation Setup  

à  Logging Buffers . Logging Buffers will contain data retrieved from 

specified PLC registers and could  kept the da ta at Battery Backup RAM 

in the HMI. For information about Setting Logging Buffers, please refer 

to the ADP Software User’s Manual. 

Historical Trend Graph 

HMI may set fixed sampling period or the PLC may as well initiate a 

data read from the specified registers and store the data into the Logging 

Buffers in the HMI memory. After a long period of sampling, data is 

converted into continuous curve(s) and is displayed on the HMI screen. 

See Fig. 2-22.  
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Fig.2-22 Historical Trend Graph 

Historical Data Table 

After a long period of data sampling, data is displayed on the HMI 

screen as tabular format. See Fig. 2-23.  

 

Fig.2-23 Historical Data Table  
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Fig.2-24 Column Properties settings in Historical Data Table  

Historical Event Table 

HMI may set fixed sampling period or the PLC may as well initiate a 

data read from specified register s or related bit s  in LSB. Data is 

converted into pre-defined message text(s), and then displays 

line-by-line on the HMI screen. See Fig. 2-25. 

 

Fig.2-25 Historical Event Table  

2.8.15  Alarm Display 

There are four types of Alarm Display. To use these objects, designer 

must first set fields in Application Menu à Alarm Setup. An alarm 

address block in the Alarm Setup is a location in the PLC which HMI 

samples to ascertain the state of the alarms configured. For information 

Posi t ion of  the data in  the associated 
Logging Buffer 

Data is 16BIT or 32BIT 
(1 indicates 16BIT. 2 
indicates 32BIT.) 

The posi t ion 
of a data 
f ield in the 
tab le. 
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about Alarm Display settings, please refer to ADP Software User’s 

Manual. 

Alarm History Table 

HMI reads the reference bits in the PLC, activate s the corresponding 

alarm massages, and shows them on the screen in a sequence as an alarm 

history table. See Fig. 2-25.  

 

Fig.2-26 Alarm History Table  

 

Note: There are ”S”, “A”, “C” symbols in the Alarm 
History Table , and they indicate: 

”S”àAlarm state is unaccounted for during design 
”A”à In the HMI operation, alarm is present 
”C”à In the HMI operation, alarm was confirmed and 
canceled 

Active Alarm List 

HMI displays only alarm message of active alarms. 

Alarm Frequency Table 

HMI summarizes and displays alarm messages alone with their 

occurrences on the HMI screen. See Fig. 2-27.  
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Fig.2-27 Alarm Frequency Table  

Alarm Marquee 

The HMI displays alarm messages of the active alarms as moving sign 

from right to left. See Fig. 2-27a.  

 

Fig.2-27a Alarm Marquee 

2.8.16  Sub-Macro 

It has the same meaning as “sub-routine” in macros and is used 

primarily for being called from macros. A set of macro commands, 

which is frequently used or used for repeated calculations, is usually 

placed in the sub-macro and stored. It can be used or called repeatedly 

in regular macros. The designer may design up to 512 sub-macros. For 

Macro design, please refer to ADP Software User’s Manual. 

2.9.  Library 

The Library Menu allows designers to manage  Bitmap, Shape, and Text 

Libraries. 

2.9.1  Bitmap Library 

When designing a screen, load the Bitmap Library first in order to use 

stored bitmap file s (*.bmp) or AutoCAD files (*.dwg). See Fig. 2-29.  
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Fig. 2-29 Settings Dialog Box of the Bitmap Library  

Import from 

Import required graphics from ADP build-in graphic library (*.GBF). 

(Library path is C:/HITECH ADP/BmpLib/). 

Export to 

Export and save graphic in Bitmap Library as “*.GBF” file. 

Import 

Import a graphic created by other  Graphing Software, such as Microsoft 

Paint, into the Bitmap Library. The following file types are currently 

supported: Bitmap images (*.BMP), ADP/ADP2 graphic files (*.BMG) , 

and AutoC AD files (*.DWG/*.DXF). 

Export 

Export and save graphics in the Bitmap Library as a *.BMP file. 

Flip/Rotate, Inverse Color, Trim, Stretch 

Edit imported graphics. Suppose a graphic is used in several screens, 
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when it is edited in the Bitmap Library and saved as the same name, all 

the graphics in various screens will be updated simultaneously.  

2.9.2 Save As Shape 

Shapes, created from ADP Draw objects, can be saved in a  Shape library 

(*.SFL) file. 

2.9.3  Shape Library Manager  

Modifies Properties of Shape s in a Shape library. For information about 

settings, please refer to the ADP Software User’s Manual. 

1.  Shape: Build from basic static Draw objects, including lines, 

rectangles, ellipses, circles, polygons, free form, and curves. 

Excludes static  text, dots, and sta tic  graphic.  

2.  A Shape may contain several states. 

3.  Unlike Bitmap, no distortion occurs when a Shape is resized.  

2.9.4  Text Pool 

Create commonly used texts in the Text Pool which then could be used 

on many objects requiring texts. 
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2.10.   Application 

The Application Menu provides the functions  for application 

compiling/downloading to the HMI, file protection, system 

messages, etc .  

2.10.1 Workstation Setup 

This menu item provides parameter declarations  for HMI and PLC, 

including the HMI model, make and model of the connected P LC, 

printer model, startup  screen upon the HMI boot-up, 

enable/disable of multi-language support, and locations of 

controls and status blocks. See Fig. 2-31. For information about 

settings, please refer to the ADP Software User’s Manual. 

 

Fig.2-31 Dialog box of Workstation Setup  

General 

For information about specific meanin gs  of each field, please refer to 
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ADP Software User’s Manual. 

Control Block 

Enable designers to control the HMI operation 
mode directly with the PLC program, e.g., 
screen switching, and hardcopy. The minimum 
length is 2 words, the maximum 32. The length 
increases proportionally with functions 
implemented. (For example, it requires a 
minimum of 6 words when using the Recipe 
function.  

Status Block 
Feed status of the screen back to the PLC 
register. It is a continuous data block with a 
fixed length of 6 words .  

Expanded 
Control Block 

Similar to the control block, except each word 
has a different meaning than that in control 
block. Only PWS1760 / 3160 / 3260 / 3760 / 
SoftPanel supports this function.  

Expanded Status 
Block 

Similar to status block, except each word has a 
different meaning than that in status block. 
Only PWS1760 / 3160 / 3260 / 3760 / SoftPanel 
supports this function.  

 

 

Note: Expanded Control Block and Expanded Status 
Block do not support special functions currently.  

Communications 

Set parameters for the PLC connection. When HMI and PLC are 

connected together, their Transmission Setup must be identical to 

function correctly. Otherwise, the connection will fail. For example, set 

the communication format of the Mitsubishi FX2N PLC as 9600bps, 7, 

even, 1 stop bit, RS422, with the PLC station number=0. As well as set 

parameters for connections to other HMIs. For information about 

settings, please refer to the ADP Software User’s Manual. 

Miscellaneous 

Set the recipe and calendar functions. For information about settings, 

please refer to the ADP Software User’s Manual.  
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Fig. 2-32 Dialog box of Miscellaneous Settings  

Note: Write Time and Date to the PLC at location D100.  

Hour (BIT1 5- 0 8  in D100 ) Minute (BIT0 7 - 0 0  in D100) 

Month (BIT15 - 0 8  in D101) Day (BIT0 7- 0 0  in D101 ) 

Week (BIT15 - 0 8  in D102) Year (BIT07 - 0 0  in D102) 

 

 

Note: For the value of w e e k: 

PWS1711/3720 is 1-7 (Sunday-Saturday), and PWS1760/ 
3260/3760/SoftPanel is 0-6 (Sunday-Sa turday).  

Logging Buffers 

Before using the Histor ical Display objects, this area must be set first. 

There are 12 buffers available. For information about settings, please 

refer to the ADP Software User’s Manual. 

2.10.2  Tag Table 

Enable the designer to use familiar language to define the association 

between PLC data addresses and HMI objects. Suppose the original push 

button is associated to PLC bit  Y0. “Motor  ON” could replace it. The 

designer can change the Tag Table easily. Only make changes to the Tag 

once and the objects in the entire application referring to the Tag is 

updated. It is not required to modify each object. Consistency check for 

PLC addresses and their usage can be made  easily. See Fig. 2-33.  
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Fig.2-33 Dialog box of Tag Table  

No Tag numbers up to 1024 tags. 

Name  
Tag Name with max. length of 22 characters.  
The first character cannot be a number or 
special character and no space is allowed.  

Address  PLC or HMI internal address that the Tag is 
referring to.  

Comment Description of a Tag with max. length of 255 
characters .  

 

Fig.2-34 Example of using Tag Table in On/Off buttons 

2.10.3 Set Alarm 

This area must be set first before using the Alarm Display objects . See 

Fig. 2-35. There are maximum of 512 alarms  could be define. For 

information about settings , please refer to ADP Software User’s 
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Manual. 

Address of Alarm 
Block  

Specifies the starting address of a block of 
PLC registers for the HMI to monitor as the 
status of alarms. 

Scan Time 
(second)  

Indicates time period, in which the HMI scans  
PLC for possible alarms. The unit for the Scan 
Time is second.  

Number of 
Alarms 

The maximum Alarm records: If it is 1000, 
upon the 1001st alarm occurrence, the first 
alarm will be replaced.  

 

Fig.2-35 Dialog box of Alarm Setup 

2.10.4  Common Keys 

A common key has the same function, no matter operated in which 

screen. For example, define ”K1” as “switch to screen One ”. No matter 

in any screen, whenever the operator presses the “K1” key, the screen 

switches to the screen One. In contrast, auxiliary keys defined in Screen 

Prope rties dialog box applies to the  selected screen only. For example, 

define  ”K1” as “switch to screen One ” in the screen Five . When the 

operator presses the “K1” key, the screen switches to the screen One 

only in the screen Five. In all other screens , it does not work.  

 

Note: PWS3760/PWS3720/2100/700X/500S support this 
function.  
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2.10.5  System Messages 

It is used to define the HMI system messages and the message s could be 

changed as designer requested. See Fig. 2-36. There is a complete 

message system (*.PSM) in all 4 different languages under the 

“C:\HITECH ADP” directory.  

 

Fig.2-36 Dialog box of System Message s 

2.10.6  Report format 

Setting report format and then printing on Printer for data backup on 

collected History Data, Alarm Messages, and Recipes. For information  

about settings, please refer to the ADP Software User’s Manual. 

 

Note: Only SoftPanel supports this function currently.  

There are 3 data resources: 

1.  Alarms –  including Alarm History, Alarm Frequency, Active  Alarm 

2.  Logging Buffers –  Maximum of 12 buffers 

3.  Recipes  

As a result, user must define  data resource first. See Fig. 2- 37. Secondly, 

add New Report and specify Settings in Report Format. See Fig. 2-38. 
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Finally, use the Action button to select report format for printing. See 

Fig.2-39 for results. 

 

Fig.2-37 Dialog box for editing Logging Buffers  

 

Fig. 2-38 Dialog box of editing Report Format 
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Fig.2-39 Printing result of Report Format 

2.10.7  Initial Macro  

For the first time HMI runs the application (usually after power failure, 

first time power up and run application), execute the commands in 

Initial Macro once.  

2.10.8  Background Macro 

When HMI runs the application, the commands in Background Macro are 

executed repeatedly. However, it runs only 30 lines of commands at a 

time. Furthermore, no matter HMI is in which screen, the Background 

Macro will always be executed. 

2.10.9  Clock Macro 

When HMI runs the application, the commands in clock macro are 

executed repeatedly every 500ms. 

2.10.10 Compile 

When an application is being compiled, compiling status is displayed on 

the screen. If there is any compiling error, click the “OK” button to 

display the error message. If there is any error, it requires correction and 

re-compile. 
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2.10.11 Download Appliction 

ADP will download the current complete application  to HMI, best for 

downloading modified applications .  

2.10.12 Download Firmware and Appliction 

ADP will download both the application and firmware to HMI, best for 

first-time download or system parameter modification. (For example, 

change the PLC model). 

 

Note: Application has to be compiled before being 
downloaded.  

PWS500/700/1711 support only application download.  

PWS1760/3160/3260/3760 support both. 

2.10.13 File Protection 

Designer may set password to protect an application. The maximum 

length of password is 10-character. Pay attention to the case of alphabet 

characters. Password is activated by the “Save File” action.  

 

Note: If the password is lost, application can never be 
opened.  Please k e e p the password safe .  
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2.11.   Tool 

The tool Menu provides On-line/Off-line management functions.  

2.11.1 Off-line Simulation 

Execute and verify an application  on PC directly. Connection with the 

PLC is not required. Before purchasing HMI, you can simulate HMI 

operations and get to know HMI better.  

2.11.2  On-line Simulation 

Using PC as HMI, simulate On-line operation by connecting PC and PLC 

via the communication ports. The simulation can only run for 60 minutes. 

If you need to continue the simulation,  close the ADP software and 

restart ADP. For information about what PLCs On-line simulation 

supports, please refer to the ADP Software User’s  Manual.  

2.11.3  View/Edit Recipes 

Retrieve for editing and printing the  *.RCP file, which is uploaded from 

HMI to PC. Note: Recipe  data of *.RCP type must be uploaded from 

HMI and saved. As a result, length of recipe  records and total number of 

recipes cannot be  changed. For detail ed information, please refer to the 

ADP Software User’s Manual. 
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2.12.   Options  

Options Menu provides the functions  to manage transmission 

setup between PC and HMI, language selection for ADP Graphical 

User Interface environment.  

2.12.1 Grid Attributes 

User may define ADP to align objects to grid s of the specified 

spacing according to the width of X and height of Y.  

2.12.2  Transmission Setup 

You can define  the transmission parameters between P C and HMI 

through communication ports COM1~COM4 and its transfer rate. If you 

cannot download, please check if the COM port is already opened or the 

connection cable is of the  right type. See Fig.2-42. 

 

Fig.2-42 PC to HMI connection 
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2.12.3  Language Selection 

You can select different language s for the ADP Graphical User In terface 

environment. Currently, all language versions  are integrated in the same 

ADP installation, and there is no need to install multiple versions of 

ADP for different languages. Simply use this option to change the 

language version of ADP. 

 

Note:  For changes to take effect, re-start ADP after 
changing the language.  
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2.13.   LadderPlus 

The main function of the LadderPlus Menu is to provide the functions 

for PC to monitor  the Ladder Programs running in HMI and to switch 

to LadderPlus design window. For detail  information, please refer to 

the  ADP Software User’s Manual. 

2.13.1 Start Monitor 

You may monitor or control I/O addresses  and registers of PLC on the 

ADP windows. The connection used for monitoring is identical to that 

in Section 2-10, as in Fig. 2-42 shows. Sa mple rate of monitoring is 

fixed at 19200 bps. 

 

Note:  Currently only PWS500S-PLC model is supported.  

 

2.13.2  Ladder  

Switch to the LadderPlus  design window, as in Fig. 2-44. For 

information about Statements, please refer to the ADP Software User’s  

Manual. 
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Fig.2-44 Ladder Design window 

2.13.3  Statement Lists  

Switch to “Statement Lists” window. Currently a designer can only view 

the Ladder’s compiled STL program, input mode is not supported. See 

Fig. 2-45.  
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Fig.2-45 Statement Lists window 

2.13.4  Status Chart  

Switch to the Status Chart monitor window. This allows the designer to 

monitor or control I/O addresses and registers. See Fig.2-46.  

 

Fig.2-46 Status Chart window  

2.13.5  Initial Values  

Switch to the Initial Values settings window. Provide  default internal 

register value for the HMI initialization. See Fig.2-47.  

 

Fig. 2-47 Initial Values window 

2.14.   Window 

Select Tile or Cascade display in the Window pull-down menu.  

 

 

2.15.   Help 

Provide  help for Macro command and LadderPlus.  

Select About to see software version.  
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Fig.2-50 Software version and description 
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3. Exercise: Create a Simple 

Application 

This section introduces procedures to design an application with screens 

and basic  objects and to help a beginner complete a real design in a snap. 

It also provides step-by-step procedures for connecting HMI to PLC and 

cautions for setting parameters. The instructions here are intended for 

the Mitsubishi FX2N PLC and PWS1711-Macro HMI. 

3.1.  Create a New Application 

There are 2 ways  to create a new application: select “New” from file 

menu or short cut  in the toolbar. A dialog box will pop up when a 

new application is created. See Fig. 3-1.  

 

Fig.3-1 Dialog box for Creating a  New Application 

Application Name  

Application Name is the description of an 
application, not the actual file name saw in file 
manager. Actual file name is the one that you 
used for saving application.  

Panel/Workstation 
Type 

Click the arrow to select PLC model from 
pull-down list (Mitsubishi FX2N is used as the 
example in this section).  

Controller/PLC 
Type 

Click on the arrow to select HMI model from 
the pull-down list (PWS1711-Macro is used as 
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Type the pull-down list (PWS1711-Macro is used as 
example in this section).  

 

3.2.  Design “Motor Startup and Speed Monitor” Screen 

After entering  the application name, t he HMI model, and connected PLC, 

click the “OK” button and a window will pop up. See Fig.3-2. ADP 

opens the “screen #1” automatically.  

  

Fig.3-2 Create  New Application window 

3.2.1  Create “Motor Startup and Speed Monitor” Screen 

Go to Propertie s option in Screen menu, as in Fig. 3-3. Change the 

screen name to “Motor Startup and Speed Monitor”, as in Fig.3-4.  
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Fig. 3-3 Screen Properties dialog box 

 

Fig.3-4 Screen #1 “Motor Startup and Speed Monitor” 

3.2.2  Create “Motor Startup/Stop” Maintained Button 

Place a Maintained button in screen #1 “Motor Startup and Speed 

Monitor.” The button has the following attributes: 

1.  Write: Y0 (Mitsubishi FX2N PLC Output contact)  

2.  Read: Y0 
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3.  Operator Confirmation: when the button is clicked, it will ask the 

operator for confirmation prior to notify ing the PLC. Set the 

maximum waiting time to 20 seconds. 

4.  Frame: “Raised”.  

5.  State 0 (OFF) displays “Motor Stopped” text. The font size is set as 

“8x16” with background color “white” and font Color “black”. 

6.  State 1 (ON) displays “Motor Started” text. The font size is set as 

“16x16” with background color “black” and font color “white”.  

7.  State 0 uses “Symbol001” in Bitmap library “SYMBOLS.GBF” as 

bitmap. The bitmap color is “white” and background color is “black”. 

8.  State 1 uses “Symbol001” in Bitmap library “SYMBOLS.GBF” as 

bitmap. The bitmap color is “black” and background color is “white”. 

Design procedures are described in following sections. 

Create “Motor Startup/Stop” Maintained Button 

Select the Maintained button from Object menu’s pull-down, as shown in 

Fig. 3-5. Or select the  icon from the Basic Objects toolbox.  

 

Fig.3-5 Selecting the Maintained button from the  Object menu’s 

pull-down 
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After  the Maintained button is selected, move the mouse pointer to the 

screen workspace. The pointing arrow becomes a cross, and you may 

now place an object on the window. See Fig.3-6.  

 

Fig.3-6 The mouse pointer becomes a cross after the button is selected 

Move the cross to the place where you would like to place the button 

defin ing the  upper left corner of the button. Click the left mouse button 

once and drag the mouse. A rectangle appears on the screen. See Fig. 3- 7. 

Drag the mouse to adjust its size. When the desired size is reached, click 

the left mouse button once more. See Fig. 3-8. When the ope ration is 

completed, the mouse pointer returns from a cross back to an arrow. 

When this procedure is completed, both the button position and size are 

set . 

 

Fig.3-7 Hold the  left mouse button and drag; a rectangle appears.  
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Fig.3-8 When the  button is placed, the mouse pointer returns to an arrow 

Set Attributes of the “Motor Startup/Stop” Maintained Button 

Move the mouse pointer (õ) to an area within the  button and double 

click the left mouse button. Or select the  Object Attributes option from 

the  Edit Menu. A dialog window pops up on screen, as in Fig. 3-9. On 

the Attributes tab, put Y0 in “Write” to indicate that the button controls 

the Y0 field in PLC. Put Y0 in “Read” to indicate that the button also 

reads state of Y0 from PLC. If “Read” field is not spe cified, the value in 

“Write” is applied. You are allowed to specify a different value. Check 

“Operator Confirmation” to indicate that the operator will be asked for 

confirmation when the  button is pressed prior to notifying PLC. When 

button is pressed, HMI pops up with a  ”Are you sure?” window. “Set 

waiting time to 20 seconds” means  that ”Are you sure?” window will 

display for 20 seconds. If ”Yes” button is not pressed, after 20 

seconds , ”Are you sure?” window is dismissed and no signal will be sent 

to PLC. 
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Fig.3-9. Attributes settings dialog box 

Set Shape of “Motor Startup/Stop” Maintained Button 

Select the Shape tab. Click the  “Select” button to select the frame as 

“Raised,” as shown in Fig. 3-10. Change the button’s position on screen 

and button size in  the  “Outline” field. It is not required to close the 

“Properties” menu, when using this method to adjust the button’s 

position and size. Click on “Redraw” to see the results. There is another 

way of doing this. To resize the button, close “Properties” menu and 

position the mouse pointer at any of the 8 tiny rectangles on the frame’s 

border. The mouse pointer becomes a two-headed arrow (ó ). Click, hold 

the left mouse button and drag the mouse to resize the button. See Fig. 

3-11. To relocate the button, move  the mouse pointer to the area within 

the button. Click and hold the left mouse button and the cursor will 

become a moving pointer ( ). Move the mouse, and the button moves 

as well to the new location. See Fig. 3-12. Use the state tab to set icons, 
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icon colors, background colors, and to enable  blinking for the button.  

 

Fig.3-10 The Button Shape Settings dialog box 

 

Fig. 3-11 Resizing the button  
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Fig. 3-12 Repositioning the button  

Set States of the “Motor Startup/Stop” Maintained Button 

Since there are only 2 states for a Maintained button, it is not required 

to add or delete state(s), as shown in Fig. 3-13.  

 

Fig.3-13 The Button State Settings dialog box 
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Set text for the “Motor Startup/Stop” Maintained Button 

Type “Motor Stopped” in  the text input field where state  is 0, located in  

the  text tab. Set the text size as “8x16,” with background color as 

“white” and text color as  “black.” Type “Motor Started” in  the text input 

field of state  1. Set the text size as “16x16,” with the background color  

as  “black” and the text color as  “white”, as in Fig. 3-14. (Use  a font size 

bigger than “16x16” for Chinese text.)  

 

Fig.3-14 Text dialog box of the  toggle button 

Another way to input text is to input text in  the  Text Input field on the 

Text toolbar, as in Fig. 3-15.  

 

Fig.3-15 Text toolbar 
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To relocate  the  text display within the button, click on the button and 8 

tiny rectangles appear on the frame’s border. Click on the text and a 

dotted rectangle  appears, as in Fig. 3-16. Hold the left mouse button and 

drag the mouse to move the text.  

 

Fig.3-16 Relocate text display 

Set Bitmap for the “Motor Startup/Stop” Maintained Button 

Go to the Graphic  tab and select “Symbol001” in the Bitmap library 

“SYMBOLS.GBF” as State 0 bitmap. Set the bitmap color as “white” 

and the background color as “black”. For state 1, use “Symbol001” in 

the Bitmap library “SYMBOLS.GBF” as the bitmap.  The bitmap color is 

“black” and the background color is “white”. See Fig. 3-17.  
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Fig.3-17 Momentary button Graphic  settings dialog box 

Another way to incorporate bitmap is to select a  bitmap in the “Select 

bitmap” field in  the  Bitmap toolbar, as in Fig. 3-18. In this example, the  

ADP buil t-in Bitmap library is used. If the desired bitmap is not in  the 

Bitmap library, use the import option in the Bitmap Library menu. 

 

Fig.3-18 Bitmap Toolbar 

To relocate  a bitmap within the button, follow the same procedures for 

moving text, i.e., click on the button and 8 tiny rectangles  will appear 

on the frame’s border. Again, click on the bitmap and a dotted rectangle 

appears, as in Fig. 3-19. Hold the left mouse button and drag the mouse 

to move the bitmap.  
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Meanwhile, while  the mouse pointer is positioned at any of the 8 tiny 

rectangles on the frame ’s border and the mouse pointer becomes a 

two-head arrow, (ó ), click and hold the left mouse button, and drag the 

mouse to resize  the  bitmap. 

 

Fig.3-19 Relocating the bitmap 

Complete the “Motor Startup/Stop” Maintained Button Design 

The Maintained button design is now completed. State s 0 and 1 have 

their own text and bitmap displays. See Fig. 3-20(a) for State 0 (OFF), 

and Fig. 3-20(b) for state 1 (ON). 

 

Fig. 3-20(a)                    Fig. 3-20(b)  

3.2.3  Create the “Motor Startup and Speed Monitor” Static Text 

Place  a static text in screen #1 “Motor Startup and Speed Monitor,” with 

text size “24x24” and color “black”. Follow procedures listed in the 

following sections.  
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Setup the “Motor Startup and Speed Monitor” Static Text 

In the Draw Menu, select static text, as in  Fig. 3-21. Or click the  
icon on the Draw toolbar.  

 

Fig.3-21 Select Static Text object in Draw Menu 

When a  selection is made, move the mouse pointer to the screen 

workspace. Click the left mouse button once to define the upper left 

corner of the button, and then drag the mouse to adjust the size. Click 

the left mouse button once more until the desired size is reached, as in 

Fig. 3-22.  

 

Fig.3-22 Display Static Text  
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Set Properties of “Motor Startup and Speed Monitor” Static Text 

Move the mouse pointer to an area within the S tatic Text and 

double -click the left mouse button. Or select the Object Attributes  from 

the EDIT menu’s pull-down list. The screen displays the Static Text 

settings dialog box. See Fig. 3-23. Type “Motor Startup and Speed 

Monitor” in the  Text field and select font size  “8x16” and color “black”. 

 

Fig.3-23 Static Text settings dialog box 

Alternatively, use the text toolbar for input. See Fig. 3-15. 

Complete the “Motor Startup and Speed Monitor” Static Text  

The “Motor Startup and Speed Monitor” Static Text is now completed, as 

in Fig. 3-24. (Chinese text should use a  font size larger than “16x16”) 
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Fig.3-24 Static Text display 

3.2.4  Create “Motor Speed” Numeric Display 

Place the “Motor Speed”  text display in screen #1 “Motor Startup and 

Speed Monitor.” The text display has the following attributes: 

1.  Read PLC data  

2.  Access D200 (register in Mitsubishi FX2N PLC), one word. 

3.  Data type: unsigned binary.  

4.  Text font 16x16.  

5.  Set 4 digits for integer. 

Procedures are described as the following: 

Setup the “Motor Speed” Numeric Display 

Select Numeric Display in the Object Pull -down menu, as in Fig. 3-25. 

Or select the  icon from the Basic Objects toolb ox.  
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Fig.3-25 Select Numeric Display from Object Pull-down menu 

When selection is done, move  the mouse pointer to  the screen workspace. 

Click the left mouse button once then drag to the desired size. Click the 

left mouse button once more upon completion, as in Fig. 3-26.  (“####” 

appears as default display value.) 

 

Fig.3-26 “Motor Speed” numeric display 

Set Attributes for the “Motor Speed” Numeric Display  

Move the mouse pointer into the Numeric Display object, and double 

click the left mouse button. Or select Object Attributes from the  “EDIT 

menu” pull-down list. The Numeric Display settings dialog box will 
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appear on the screen, as in Fig. 3-27. Enter “D200” in the “Read” field. 

Select “single word.” Set “4” in “integer digits” field, and “16x16” in 

the  “font ” field.  

 

Fig.3-27 Numeric Display settings dialog box  

Complete the “Motor Speed” Numeric Display 

The design of the Numeric display object is now complete. 

Create the “Motor Speed Display” Static Text 

Follow the procedures described in section 3.2.3 for Static Text and build a “Motor 

Speed Display” Static Text with a  font size of “8x16”, positioned above the Numeric 

Display. Build an “RPM” Static Text with font size “8x16”, located to the right of 

the Numeric Display. See Fig. 3-28.  



  Exercise: Create  a Simple Application 

Version 3   ADP Software Quick Manual 3 -1 9 

 

Fig.3-28 “Motor Speed Display” Static Text 

3.2.5  Create “Motor Startup/Stop” Multistate Indicators 

Place “Motor Startup/Stop” Multistate Indicators in screen #1 “Motor 

Startup and Speed Monitor.” It has the following attributes: 

1.  Read: M0 (Contact in Mitsubishi FX2N PLC) 

2.  Data type: bit 

3.  Frame: “Round1”  

4.  No text display for both states 0 and 1 

5.  Use a  monochromatic bitmap created by Windows paintbrush for 

graphic  display 

Procedures are described in the following: 

Setup the “Motor Startup/Stop” Multistate Indicators 

Select Indicator ->Multistate Indicator from the  Object pull-down menu, 

as in Fig. 3-29. Or select the  icon on the Basic Objects toolbox.  
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Fig.3-29 Select Multistate Indicator from the object pull-down menu 

When the selection is done, move the mouse pointer to the screen 

workspace. Click the left mouse button once to define the button’s upper 

left corner, and then drag the mouse to the desired size. Click the left 

mouse button once upon completion, as in Fig. 3-30.  

 

Fig. 3-30 Multistate Indicator object 
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Import Bitmap for the “Motor Startup/Stop” Multistate Indicator 

Select the  Bitmap Library in the Library pull-down menu, as in Fig. 

3-31.  

 

Fig.3-31 Bitmap Library in  the Library pull-down menu 

Click the “Import” button in the  Bitmap Library dialog box. Select a 

monochromatic bitmap image created by Windows paint. When the 

conversion is done, enter a file name to save the bitmap in the “Bitmap 

Library”, as in Fig.3-32. When this is done, click “Close” to return to 

screen workspace.  

 

Fig. 3-32 Import bitmap image file (*.bmp)  
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Set Attributes of “Motor Startup/Stop” Multistate Indicator 

Move the mouse pointer into  the Multistate Indicator object, and double 

click the left mouse button. Or select Object Attributes from the EDIT 

pull-down menu. Multistate Indicator settings dialog box will appear on  

the  screen. Put M0 (contact in FX2N PLC) in the  “Read” field. Set the 

data format as “bit”, frame as ”Round1”, as in Fig. 3-33.  

 

Fig.3-33 Dialog box of Multistate Indicator Attributes 

Set Shapes of the “Motor Startup/Stop” Multistate Indicators 

Switch to the shape tab; select the background color of state 0 as 

“white” and state 1 as “black”, as in Fig.3-34. 

If data type is Value,  
the address put in 
“Read” must be a 
16-bit data. The 
maximum state 
allowed is 256. 
If data type is LSB, 
the related bit is 
taken. The address 
put in “Read” must 
be a 16-bit data. 
The maximum state 
allowed is 16.  
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Fig.3-34 Multistate Indicator Shape dialog box 

Setup Graphic of the “Motor Startup/Stop” Multistate Indicator 

Switch to the  Graphic  tab, select bitmaps  for state s 0 and 1 by typing a file name in 

the Bitmap Image field, i.e., the bitmap imported in “Import bitmap for Motor 

Startup/Stop Multistate Indicator” section. Change  the color of the  bitmap as well, 

as in Fig. 3-35. Or use  the  Bitmap toolbar as in Fig. 3-18.  
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Fig.3-35 Multistate Indicator “Graphic ”  tab 

Complete the “Motor Startup/Stop” Multistate Indicator Design 

The “Motor Startup/Stop” Multistate Indicators design is completed. Fig. 

3-36(a) is for state 0 (off), Fig. 3-36(b) for state  1 (on).  

 

Fig.3-36(a)                      Fig.3-36(b) 
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3.3.  Design the “Set Motor Speed” Screen 

3.3.1  Create the “Set Motor Speed” Screen 

Select the new screen from the Screen Pull-down menu, as in Fig. 3-37. 

Or select the  icon from the standard toolbar to create  a new screen. 
Set the “Screen Name” field as “Set Motor Speed” and “Number” as “2”  

as shown in Fig. 3-38.  

 

Fig. 3-37 The New screen in the Screen menu’s pull-down 

 

Fig.3-38 Create a New Screen 

3.3.2  Create “Motor Speed” Numeric Entry object 

Place a Numeric Entry object in screen #2 “Set Motor Speed.” It has the following 

attributes: 

1.  Write : D200 (register in Mitsubishi FX2N PLC), one word.  
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2.  Read: D200 

3.  Data type: unsigned binary.  

4.  Notify: M20 (Contact in Mitsubishi FX2N PLC). Notify PLC when 

the  input data value is ready.  

5.  Text font: 16x16.  

6.  Set 4 digits for the integer.  

7.  Input range: the upper and lower limits to qualify operator’s input 

value. Lower limit is 0 and the upper limit is 3000, in this example. 

Procedures are described as follow s: 

Setup the “Motor Speed” Numeric Entry object 

Select the  “Numeric Entry” in the Object pull-down menu, as  in Fig. 

3-39. Or select the  icon on the Basic Objects toolbox.  

 

Fig.3-39 Select Numeric Entry from the  Object pull-down menu 

When selection is done, move the mouse pointer to  the screen workspace. 

Click the left mouse button once to define the button’s  upper left corner, 

and then drag the mouse to its desired size. Click the left mouse button 

once more upon completion, as in Fig. 3-40. 
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Fig.3-40 Numeric Entry object 

Set Attributes of the “Motor Speed” Numeric Entry object 

Move the mouse pointer into  Numeric Entry object, and double click the 

left mouse button. Or select Object Attributes from the EDIT  menu’s 

pull-down list.  The Numeric Entry settings dialog box will appear on 

screen. Put “D100” in the “Write” field, “D100” in the  “Read” field, and 

“Unsigned Binary” in “Format”. Set the  “Frame” field as “DEF04”, the  

“Notif ication” field as ”M20”, and select the  “After Writ ing” option 

button. (Notify PLC when the data input is completed.) Set “Font” as 

“16x16”, “Integra l Digits” as “4”, “Min” input limit as “0”, and “Max” 

input limit” as “3000”. See Fig. 3-41. 
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Fig.3-41 Numeric Entry object settings dialog box 

3.3.3  Create “Set Motor Speed” Static Text 

After setting up the Numeric Entry object using the procedures 

described in section 3.2.3 “Design Motor Startup and Speed Monitor 

Static Text,” design a static text “Set Motor Speed.” Set the font to 

“24x24” and place it above the Numeric Entry object.  

3.3.4  Create “RPM” Static Text 

Again, design a static text “RPM” with font size “8x16” and place it to 

the right of the  Numeric Entry object.  

3.4.  Design for Switching Screens  

3.4.1  Open Screen 

Select “Open” from the Screen pull-down menu, as in Fig. 3-42. Or 

select the  icon on the standard toolbar. Open the previously saved 

Screen #1. A dialog box pops up for opening the existed screen, as 

shown in Fig. 3- 43. The selected screen is displayed on the preview pane.  
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Fgi.3-42 Select “Open” from the “Screen” pull -down menu 

 

Fig.3-43 The Open Screen dialog box 

Place a “Goto Screen” button in screen #1 “Motor Startup and Speed 

Monitor” to change screens. It has the following attributes: 

1.  Specify “Open/Go To” as “Set Motor Speed.” 

2.  Frame: “Raised.” 

3.  The text “Set Motor Speed” is displayed in  the “Goto Screen” 

button. Set the font to “16x16”, the font color to “black” and the 

background color to “white”.  

Procedures are described as follow s: 

A preview 
pane to 
display 
selected 
screen 
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3.4.2  Create “Goto Screen #2” Button 

Select the “Goto Screen” from the “Push Button” sub menu in the Object 

Menu, as in Fig. 3-44. Or select the   icon on the Basic Objects 

toolbox.  

 

Fig.3-44 Select Object Menu -> Push Button -> Goto Screen 

When a  selection is made, move the mouse pointer to the  screen 

workspace. Click the left mouse button to define the upper left corner, 

then drag the mouse to its desired size. Click the left mouse button once 

again  upon completion, as in Fig. 3-45. 
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Fig.3-45 Goto Screen button 

Set “Goto Screen” button attributes in the “Motor Startup and Speed Monitor” 

Screen 

Double click the left mouse button on the Goto Screen button, which 

was created in section 3.4.2. Or select “Obje ct Attributes” from the  

“EDIT” pull-down menu. “Goto Screen button attributes” dialog box 

will pop up on screen. Select “Open/Go To ” as “2 – Set Motor Speed” 

and “frame” as “Raised”, as in Fig. 3-46. 

 

Fig.3-46 “Goto Screen” Button attributes dialog box 

Set text of “Goto Screen” Button 

Select text tab, type “Set Motor Speed” in the text field. Set the  font to 

“8x16”, the color to “black” and the  background  to “white.” See Fig. 

3-47. Or use the text toolbar to set it, as in Fig. 3-15. 
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Fig.3-47 “Change Display Button” text dialog box 

 

Complete “Goto Screen” Button design in “Motor Startup and Speed Monitor” 

“Goto Screen” button in screen #1 “Motor Startup and Speed Monitor” is 

completed. See Fig. 3-48.  

 

Fig. 3-48 “Goto Screen” button in screen #1 “Motor Startup and Speed 

Monitor” 

3.4.3 Create “Return to Screen #1” Button 

Place a Goto Screen button in screen #2 “Set Motor Speed” to return to 
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screen #1 “Motor Startup and Speed Monitor,” using procedures 

described in section 3.4.2. See Fig. 3-49.  

 

Fig. 3-49 Goto Screen button in screen #2 “Set Motor Speed”  

When you complete designing a screen, it is recommended to save  the 

application file immediately before you do anything else.  

3.4.4  Save File 

Select “Save” or “Save As” option from “File Menu” pull-down list, as 

shown in Fig. 3-50. Or select the  icon on standard toolbar.  

 

Fig. 3-50 Select “Save” or “Save As” from the “File Menu” pull-down 

list 
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3.4.5  Open Existed File 

Select “Open” from “File Menu” pull-down list, as shown in Fig. 3-51. 

Or select the  icon on the standard toolbar.  

 

Fig. 3-51 Select “Open” from the “File Menu” pull-down list 

3.4.6  Compile 

When you complete designing an application, please compile it before 

downloading it to The HMI. Select the “Compile” option from the 

“Application” Menu pull-down list, as shown in Fig. 3-52. Or select the 

 icon on the standard toolbar. When compil ing an application, ADP 

displays a “compile status” window. Compilation results are displayed 

automatically. All error messages will be listed in the compile status 

window, if there ar e errors. See Fig. 3-53. If there are compilation errors, 

it must be fixed before recompiling.  Results from compiling an 

application must be completely error free.  Only then is the application 

ready for downloading to the Flash memory in The HMI for execution.  
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Fig. 3-52 Select “Compile” from the Application Pull-down menu 

 

Fig. 3-53 Compilation Error Messages  
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3.5.  Download from PC to HMI 

Procedures for downloading an application to HMI, as well as cautions 

for setting parameters will be covered in this section. 

3.5.1  PC/HMI Communication Cable 

The “Download” process is where PC sends programs  to HMI by means 

of communication media (RS232). As a result, you will need a 

communication cable. See Fig. 3-54 for the connection. 

 

Fig.3-54 PC to HMI connection diagram 

3.5.2  ADP Communication Settings 

Select “Transmission Setup” in  the “Options” menu pull-down, and a 

Transmission Setup dialog box will pop up, as in Fig. 3-55. In the 

Transmission Setup dialog box, the COM Port indicates the 

communication ports of the PC.  Set the  Baud Rate as required. If there 

are more than 8 characters in the directory name in which the  file is 



  Exercise: Create  a Simple Application 

Version 3   ADP Software Quick Manual 3 -3 7 

saved or in the application file name itself, please change  the  selection 

to the “Windows Version” for application download.  

 

Fig.3-55 Transmission Setup window 

3.5.3  HMI Hardware Settings 

Adjust the DIP -switch located at the back of the HMI panel to SW7=ON. 

This enables the system menu to display and allows the application 

downloading at system boot-up. (Other DIP -switch locations, SW1~SW6 

and SW8~SW10, use the manufacture’s default settings.) When HMI is 

powered up (DC24V) and self -testing is completed,  the system menu is 

displayed as in Fig. 3-56. Press “Configure” and a screen shows up, as 

in Fig. 3-57. In  the “Download/Upload/Copy port” field, specify a HMI 

communication port for the PC to download the application to HMI. The 

COM2 communication port in the HMI is used here.  
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Fig. 3-56 System Menu of HMI 

 

Fig. 3-57 Hardware settings 

3.5.4  Download 

After connecting the PC to the HMI with the communication cable, press 

the ”Download AP/PGM” button, located at the upper left of the HMI 

system menu. The HMI enters a receiving mode to download the 

application from the PC. “Waiting for downloading” is displayed. Select 

“Download Firmware and Application” from the ADP Application 

menu’s pull-down list. The application should now be downloading to 

the HMI.  

Download Application 

ADP should download only the  application to the HMI. Suitable for 

downloading changed applications. 

Download Firmware and Application (my note: see 2.10.12) 

ADP downloads  both the  application and firmware to the HMI. Suitable 

for the first-time download. 

PWS500/700/1711 supports only application download, and 

PWS1760/3160/3260/ 3760 supports both application and firmware 

download.  

If the  download is interrupted prior to completion, try to find the source 

that caused the failure, such as a  connection to a wrong COM port. After 

the problem is fixed, go through the download process again. If the 
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download is successful, the HMI will display “Downloading completed.” 

3.6.  Connect HMI to PLC 

Procedures for connecting HMI to PLC, as well as cautions for setting 

parameters are covered in this section.  

3.6.1  HMI/PLC Communication Cable  

Before connecting HMI to PLC, please prepare a HMI/PLC 

communication cable. See Fig. 3-58.  The  PWS1711 HMI and Mitsubishi 

FX2N PLCs are used here. For more information about other PLC 

models, please refer to the ADP Software User’s Manual. 

 

Fig. 3-58 Communication cable  from PWS1711 COM2 to Mitsubishi 

FX2N PLC  

3.6.2  ADP Communication Settings 

Select “Workstation Setup” in the  “Application” pull-down menu, and 

then click the “Communications” tab in the pop up dialog box, as shown 

in Fig. 3-59. In the dialog box, set the  Controller/PLC station to “0”, the 

HMI station to “0”, the Baud Rate to “9600”, Data Bits to “7 bits”, 

Parity to “Even”, Stop Bits to “1 bit”, the PLC Communication Port to 

“COM2” port, Connection to “Normal”. (If Transmission Setup in PLC 

is modified, set parameters accordingly). 
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Fig. 3-59 Communications  tab in Application -> Workstation Setup 

dialog box 

3.6.3  HMI Hardware Settings 

On the HMI system menu, displayed as in Fig. 3-56, press ”Configure” 

and a screen shows up, as in Fig. 3-57. Make adjustment s as follows: 

PLC Communication port à COM2 

Baud rate à  9600 

Data bits à  7 

P arity à Even 

Stop bits à  1 

Workstation node address à 0 

 

Note: 

If the DIP -switch, located at the back panel of the HMI, 
is set to DIP -SW5=ON, then use the HMI Hardware 
Setting as described in section 3.6.3; 

If the DIP -switch, located at the back panel of the HMI, 
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is set to DIP -SW5=OFF, then use the ADP 
Communication Settings  as described in section 3.6.2.  

3.6.4  Connecting HMI to PLC 

After  connecting the  PLC to the HMI via an appropriate communication 

cable , press “RUN” in the HMI’s system menu, The  HMI will establish 

communication with the  PLC. 

(For practical HMI applications, the  HMI establishes communication 

with the  PLC automatically after powering up. Adjust the DIP -switch 

located at the back panel of The HMI to SW7=OFF.) 

If the communication connection is established successfully, the 

communication LED on the HMI’s front panel flashes regularly and 

continuously. Data from PLC will be displayed correctly on the  HMI 

screen. If the communication does not work normally, please verify if 

the cable is connected properly, transmission setup and station numbers 

are set to the same values accordingly.  

3.6.5  Communication Error Code 

Communication Errors may be classified into 3 categories as following. 

Communication Error Codes are tabulated as shown in Table 3-60.  

1.  HMI receives no message from the PLC. (Time out error, x008)  

2.  HMI receives an unrecognizable message from the PLC. (U nknown 

Message, x004) 

3.  HMI receives an error code message from the PLC, indicating that the 

command is not supported by the  PLC, such as an out-of-bound PLC 

address or a non-existent  address. An error Code will be generated, 

other than codes in categories 1 and 2. 

For example, if error code 8004 is returned, then it is both a “Write 

Error“ and “Unknown Message/Response Error”.  
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Table 3-60 Communication Error Code table  

Error Code  Causes  
0002, 8002.  PLC returns CheckSumError  
0004, 8004 Unknown Message/Response Error 
0008, 8008 Communication Time Out/No response  
0010, 8010 Invalid Function 
0020, 8020 Invalid Address 
0040, 8040 Invalid Data Value 
0080, 8080 Invalid Range 
00xx Read Error 
80xx Write Error 

 

 

NOTE:  

1.  The table is for PWS500/700/1711/2100/3100/3720 

2.  The table is NOT applicable to S7-200 PLC 

 

Congratulations!! You have finished the basic ADP training and 

exercises.  

 

 
Serious Warnings: 

Shut off the HMI power before connecting 
communication cable s. Otherwise, the electronic 
components in the communication module might be 
damaged!! 

 


